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H
er Majesty’s navy would be all at sea
without it. Your favourite TV weatherman,
courier service and dating agency use it.
Hospitals, schools, city traders and local
authorities can depend on it. Ironically,
some folk in these services, professions

and institutions would claim ignorance of the spreadsheet.
But they use applications overlaying it every day.

The progression from the typewriter to the word processor,
and the card file’s metamorphosis into the database, was the
work of hundreds of unrecognised people. But the spreadsheet
was invented and developed by two men, Dan Bricklin and
Bob Franckston. 

Bricklin was a Harvard Business School student who
realised the PC offered a breakthrough for the bookkeeper’s
traditional worksheet. He saw if one figure in a column had to
be changed, the total at the bottom of the column would have
to be erased, recalculated and replaced. But with the computer
you could have a formula instead of a fixed value for a total, so
when a figure was changed the total automatically changed.
Bricklin’s notion, coupled with Franckston’s computer
programmer skills, resulted in them both writing a program
for the Apple II in 1978 called VisiCalc.

By 1984 VisiCalc had disappeared from the market,
although vestiges of it remain in Lotus 1-2-3. Microsoft

meanwhile issued its own spreadsheet, Multiplan, the first
spreadsheet for Windows. From that grew Excel. So today the
PC owner has five main choices of spreadsheet: Microsoft’s
Excel, Lotus 1-2-3, Corel Quattro Pro, Sun’s StarCalc and the
spreadsheet module in Works.

All spreadsheets contain cells, which are small, rectangular
boxes arranged in numbered rows and lettered columns. For
example, cell address C3 on a spreadsheet refers to column C,
row 3. And any cell can have text, a number, a date or a formula
entered in it. The root concept is if any fixed value is changed,
the cells containing formulae instantly update. This easily lets
you project hypothetical situations, such as what would
happen to a supermarket’s bottom line if its bakery
department increased sales by five per cent. 

Spreadsheets also contain lots of built-in formulae, called
functions; Excel 2000 has 329. Many of them are common to
all spreadsheets, although entry patterns vary. For example, to
total cells in Excel you would enter =SUM(A1:A20) and in
Lotus 1-2-3 @SUM(A1..A20). Quattro Pro understands either
entry. You can nest up to seven functions within functions,
too. So to calculate the number of days until Christmas, not
including weekends, you would enter in Excel
=NETWORKDAYS(TODAY(),“25/12/2001”).

How the data in a cell is displayed is affected by the
formatting of the cell: the font specified, its colour, the colour
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of the background, how many decimal points are
used and so on. Excel uniquely offers
Conditional Formatting so that the highest or
lowest value in a range can be displayed in a
different colour, for example. Excel also offers a
Validation feature. You can restrict a cell to only
accept dates or times within certain parameters. 

Except for Works, all modern spreadsheet
files are workbooks, containing several
worksheets. A formula on one worksheet can
refer to a cell in another. In fact, it can refer to
another cell, row or column in another worksheet
in another workbook file. So if you are making a
list of temperatures in a file for 2001, and you
want to include a column of comparable
temperatures from the year 2000 file, then in
Excel you might enter into a cell at the top of a
column: =‘[Temps2000.xls]January’!$D:$D.

Assuming the other file is also open, the
selected cell in row 1 will display whatever is in
cell D1 in the worksheet named January, from the
file named Temps2000.xls. If you then point the
mouse to the bottom right-hand corner of the
cell until it turns into a cross, you can drag down
this column and all the data will appear from the
other file. That’s because $D:$D means include
all the data in the column.

Within an Excel workbook you can use
formulae in 3D. In other words, you could find
the total of all the totals in cell AA40 on all the
worksheets named January to December using
the formula:  =SUM(‘January:December’!AA40).

Works is popular because it’s bundled in the
UK with so many PC brands. You could think of
it as a cut-down version of Excel, and it’s more
than adequate for family use. It comes with so
many finished templates for sports schedules,
household expense budgeting and measurement
conversions, for example, that all of the design
work is done for most people. 

StarCalc is currently on version 5.2 and can
import files from Excel 2000 and the latest
versions of Lotus 1-2-3 and Quattro Pro, but its
main claim to fame is that it is free and will run
on Unix workstations and on PCs, including all
recent versions of Windows, Solaris or Linux.

The best known spreadsheets currently,
though, are Excel, Lotus 1-2-3 and Corel Quattro
Pro. As the principal R&D costs were written off
years ago, Microsoft, Lotus and Corel can afford
to sell them in suites: Office, SmartSuite and
WordPerfect Suite, respectively. Word processors
such as Word are included with pre-installed
suites such as Works. 

QUICK TIP
To sum values in non-
contiguous cells in Excel
and Quattro Pro enter
=SUM(, hold Ctrl, and click
on each cell. Then type the
final bracket. For ranges,
hold Shift and click the first
and last cell.

Creating a frequency distribution table

All the major spreadsheets can create
frequency distribution tables for you.

Some professions call a resulting chart of the
table a histogram. In its simplest form a
frequency distribution table looks like this
example. Quattro Pro has split the quantities
of paintings a gallery has in each listed period
into ranges called bins. For illustrative
purposes we’ve colour-keyed the results for
each bin range to the quantities of paintings
in each period.

Whichever spreadsheet package you’re
using, enter the item descriptions in

column A. Then, in column B, enter the
appropriate quantities of each item. In
column D enter your bin ranges. This example
pretends you’re a curator of a gallery with 817
paintings. The art schools, or periods, are
listed in column A, with the number of
paintings in each period in column B. We’ll
calculate the order of popularity of the
periods within the gallery.

In Quattro Pro all you do now is open
the Tools menu and choose Numeric

Tools and then Frequency. In Lotus 1-2-3 you
open the Range menu and choose Analyse,
then Distribution. In Excel, open the Tools
menu, choose Data Analysis and then
Histogram. In each case you’re led to a dialog
box in which you enter the ranges of the values
(A2:B14; in Excel use B2:B14) and the bin
values (D2:D6).

1 32

At this point Quattro Pro and Lotus
1-2-3 display the result shown in Step

1 and that’s it. Excel offers a little more. The
Excel histogram dialog box in Step 3 provides
a number of options. One of them is called a
Pareto (sorted histogram). Columns A and B
show the same results as the other two
spreadsheets, but columns C and D show the
bins sorted in descending (or optionally
ascending) order of frequency.

Another option in the Excel histogram
dialog box is cumulative percentage.

Columns A and B are the same as before, but
column C is extremely useful when creating
statistics. Here, for example, it shows that
over 38 per cent of the art periods are
represented by 26 to 50 paintings. Looked at
another way that’s five over 13 (the total of
column B) per cent. Additionally, over 69 per
cent of the periods have up to 75 paintings.

Finally, Excel automatically creates a
real histogram of the table if you

check the option in the Excel histogram dialog
box. Although we’ve taken an ultra-simple
example for this workshop, you can see how,
in more elaborate usages of a frequency
distribution table, a chart would aid
understanding. As this histogram offers the
full range of Excel charting facilities, you can
reformat it, as here, or change it to a different
chart type altogether.

5 64

The ubiquitous spreadsheet

Over the past decade, spreadsheet
applications have become an integral part of
working life. In many cases, the underlying
spreadsheet, usually Excel, Lotus 1-2-3 or
Quattro Pro, is not seen. The application runs
on top of them.

Builders and developers use spreadsheets
to estimate construction costs. These can be
based on a company’s own database or, as in
the US, extrapolated from official National
Average Construction Costs. United Design
Associates, at www.uniteddesign.com/cos_es
timating.html, offers gauging tools that
produce detailed cost estimates suitable for
preliminary budgeting, project quotes or
obtaining construction loans.

Synopsis Scientific Systems publishes the
Accord for Excel CombiChem add-in, which is
used by chemists for calculating molecular

properties or producing chemical diagrams.
See www.synopsys.co.uk/products/software/
accordxl/addons/combichem/index.html.

Institutional investors use spreadsheets for
calculating stock option prices and risk
parameters. J&E Research (www.jeresearch.
com) offers many Excel add-ins for this and
publishes other add-ins to help investors price
and manage forward contracts and futures.

Managing and evaluating often complex
test results is important in a clinical
laboratory. Analyse-it Software specialises in
statistical add-in software for Excel
(www.analyse-it.com). Analyse-it adds over 30
statistical functions to Excel, specifically for
evaluation and validation of clinical methods.

A Geographic Information System (GIS)
called GeoConcept, which graphically depicts
data listed in spreadsheet tables into maps,

has been developed by Kingswood. This can
prove invaluable to property management
companies that need to display statistical
information in map form. 

Kingwood’s GeoConcept is also used to
calculate delivery routes. Spreadsheet-based
routing and scheduling software can produce
an optimised solution that no scheduler with a
pencil and a calculator could accomplish in
the time. See www.kingswood.ltd.uk. 

GIS plays a vital role in international
development and humanitarian relief.
International aid agencies need to map the
vast amount of tabular data received from
multiple agencies. Organisations such as The
Environmental Systems Research Institute
(www.esri.com/industries), provide software
that takes spreadsheet-listed figures and
overlays them on national or regional maps.

Only companies and institutions need to
build large databases, so increasingly it’s for the
spreadsheet that people are buying suites. And
familiarity with spreadsheets can be an
employment prerequisite, as recruitment ads for
PAs and secretaries often state ‘knowledge of
Excel required’. 

Given your own free choice, which
spreadsheet you choose tends to depend on your
experience. If your employer uses Lotus 1-2-3
you’re likely to have that spreadsheet on your

personal laptop. Quattro Pro had a huge
following for years, but Excel is probably the top
seller today, despite being the most expensive.
Actually, with each updated edition of these three
popular spreadsheets they tend to copy each
other. When one introduced tabs on worksheets,
to simulate a personal organiser, they all did it.

Excel’s best exclusive built-in feature is the
ability to easily handle an array formula. It means
you can enter one formula (using Ctrl & Shift &
Enter) for all the operations you want to perform
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on a range of cells, instead of having to change
and enter it repeatedly to refer to different cells.
And Excel’s PivotTables quickly summarise large
amounts of data. You can rotate rows and
columns to see different summaries of the source
data, filter the data by displaying different pages,
or display the details of areas of interest. Excel
also has superior charting facilities. 

Its current edition is Version 9, which is best
known as Excel 2000. Excel 10, which comes in
the Office 10 suite, is on the way and most of its

new features will be to increase web integration.
It will support XML as a native format. 

Lotus 1-2-3 has always featured the most easily
understood Help files and the most functions
and, with its Millennium Edition, it added 50 new
ones. Since IBM’s acquisition of Lotus, the
SmartSuite developers have progressed with voice
recognition. Using IBM ViaVoice you can enter
data and format your spreadsheet by talking to it.
Like Excel 10, it also lets live data from the web
appear on your worksheet for analysis.

Quattro Pro offers more templates than the
other spreadsheets, so layouts have already been
designed for all the most common business and
personal applications of a spreadsheet. Also, if you
want to open an Excel worksheet in Quattro Pro,
you are more likely to retain more formatting
than if you were to open it in Lotus 1-2-3.

But Quattro Pro’s main advantage over the
other leading spreadsheets is its ability to handle
dates prior to 1900. Microsoft and Lotus
obviously underestimated the number of people

needing that facility, especially in the UK, which
needs to computerise so much historical data. 

Quattro Pro recognises dates from 1 Jan 1600
to 31 Dec 3199, whereas Excel and Lotus 1-2-3
start their dates at 1 Jan 1900. To get around the
Excel dating limitation, though, you could use
the shareware add-in, XDATE. See www.j-walk.
com/ss/excel/files/xdate.htm.

If you find yourself making repetitive entries
on a spreadsheet you can save time by writing a
macro. Excel, Lotus 1-2-3 and Quattro Pro all

QUICK TIP
To jump to the same cell in
the next worksheet in Excel,
right-click on the current
tab and choose Select All
Sheets. Then press Ctrl &
PageDown (or Ctrl &
PageUp to access the same
cell on the previous sheet).

QUICK TIP
Open an address book text
file in Lotus 1-2-3 and it’ll
divide the first and last
names, street addresses,
towns and so on, into
different columns. Simply
use the Parse command on
the Range menu.

Creating forms in Excel

A form, in spreadsheet terms, is a
dialog box for viewing, changing,

adding or deleting records in a database.
Usually that means a spreadsheet flat-file
database or list (as opposed to an indexed,
relational software application such as
Microsoft Access). Excel includes several forms
like this one for automatically downloading a
choice of current currency rates. Choose Run
Saved Query on the Data menu and select
Microsoft Investor Currency Rates.iqy.

Before creating a form you need a list.
Here’s a simple example. Certain rules

must be followed when creating a list in Excel
and they’re all explained in the Help file under
‘Guidelines for creating a list on a worksheet’.
Strictly speaking, we’ve broken one rule here
as it could be argued this is two lists on one
worksheet. But it’ll work fine with forms, as
we’ll show.

Click anywhere within the list and
choose Form on the Data menu. This

form will appear. You can add records using
the Add button, or delete them. Using
Criteria, go through the list, using the Find
Next button, look for men’s or women’s
items, say, over £200. You could also select
the range E2:F25 on the list, so when you
open the form, only the women’s items and
prices will be shown.

21 3

Names are a simple and efficient way
to abbreviate range addresses in

formulae. You’ve finished with the list for
now. In fact, you can hide it from the casual
user by choosing Format, Sheet and Hide.
Return to your Form and choose View,
Toolbars and Form. Drag the Forms toolbar
to a convenient location near your new form.
Hover the mouse over the tools to display
their names. Then select the Combo Box tool.

Draw a box over cell F8. Right-click
and choose Format Control. In the

dialog box enter TableA as the Input Range,
L1 as the Link Cell, and 4 as the dropdown
lines. Click OK. Enter the formula
=INDEX(TableA,L1,2)*G8 in cell H8. The Link
cell in L1 will indicate the item selected in the
Men’s Combo Box and the price will be
selected from the second column of TableA.
The Link cell can be anywhere out of the way.

Click on the Spinner tool in the Forms
toolbar and draw a box over cell G8.

Right-click and choose Format Control. In
this dialog box accept 0 as the Minimum
value, and 12 as the maximum value, so
people can buy a dozen handkerchiefs. Enter
1 in the Incremental value. The cell link is
where you want the result displayed. Enter
G8. Under the Protection and Properties tabs
you can accept the defaults.

8 97

But let’s press on and create a custom
form. Open a new sheet. Highlight the

range C2:H3 and format with a dark
background colour. Then on the Format menu
choose Cells, Alignment and Centre, for both
horizontal and vertical. Check the Merge cells
box. Then select Font, Ariel Black, Regular,
18pt and White. Similarly, format C4:H14 in a
light background colour. Add For Men and
For Women labels and format the Font, Ariel
Bold, 10pt and Red.

Add the labels Item, Qty, Price and
Total and format to choice. In this

example they’re in Ariel, 10pt, Bold and Italic.
Choosing Tools, Options, Colour Modify and
Custom lightens background colour. You can
restore your original colour palette shade later
by clicking the Reset button. Now adjust the
column widths and row depths to
approximate the illustration or to suit your
own form.

Press Ctrl & PageUp (or Ctrl &
PageDown) to return to your list of

items. Highlight C3:D26 (the men’s items and
their prices, plus the cells in the next row).
Choose Name on the Insert menu, then
Define. Type in ‘TableA’. Similarly, name the
range E3:F26 ‘TableB’. That’s the women’s
items and their prices, plus the cells in the next
row. Including the extra row guarantees that
items added later will be included in the
Named ranges.

54 6

Under the Size tab, make the Width
0.5cm. Right-click on cell F8, Copy

and Paste a new Combo Box in cell F10.
Right-click on the new Combo Box and select
Format Control and change the Input to
TableB and the Link cell to M1. Click on the
worksheet to release the control. Copy the
Spinner from G8 and Paste in G10. Change
the cell Link to G10. In cell H10 enter
=INDEX(TableB,M1,2)*G10. In cell H12
enter  =SUM(H8:H10).

To check everything works, return to
the data worksheet and click

anywhere in the list. Choose the Form option
on the Data menu. Click the New button and
enter ‘Hat’, in the Men box and a price in the
box below. Click Close. Return to your new
custom-made form and select the new item.
Spin the quantity of it up to 2. The form will
recalculate the new amount for these items
and the new total.

For your form to always show the
current date, enter =TODAY() in cell

D13. To move the form down, increase the
depth of row 1. Using Insert, Clip art, you can
add a decorative graphic. If you’d like your
form to lose its spreadsheet environment,
choose Tools, Options View and uncheck
every box under Window options including
scroll bars, tabs, headers and gridlines. On
the View menu, deselect the tool bars and
Formula bar.
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offer two programming languages. Their
historical ones are very simple and still produce
working macros. Each spreadsheet, however, has
added a far more sophisticated programming
language: VBA for Excel; LotusScript; and
PerfectScript, respectively. VBA enables
experienced developers to write applications which
use the underlying spreadsheet engine but display
only user-friendly dialog boxes to, say, dental
receptionists, or website visitors. See the Creating
forms workshop on the previous page.

If you haven’t the time or patience to learn a
new programming language, there’s another
option. Excel, Lotus 1-2-3 and Quattro Pro all
allow you to record a macro. In Excel, for instance,
you choose Record New Macro on the Tools
menu and then enter the keystrokes you wish the
macro to duplicate. A Stop Macro button will
appear and when you’re ready you just click on it.
Simple. You can run the macro in future with a
keyboard shortcut (such as Ctrl & Shift & M) or
design a tool button and attach the macro to it.

All the leading spreadsheets enable you to
depict your data graphically. It’s rare for a
newspaper or television news programme to
show a table of statistics to illustrate a story.
Instead, they’ll present the same data as a graph,
which clearly communicates the point that is
being made.

The next generation of spreadsheets will even
converse! You talk through the data to be
entered, and it will reply with the solutions. So
you’d better practice: ‘The rain in Spain...’. 

QUICK TIP
In Lotus 1-2-3 97 and
above, just type TOTAL 
or TOTALS at the left of
a row and totals will
automatically appear at the
bottom of each column.
But the cells below must
initially be empty.

QUICK TIP
To toggle between the
values and formulae on
your Excel worksheet use
Ctrl & ̀  (the key left of 1).
In Lotus 1-2-3, choose
the Range menu then go to
the Current Format box
select, Formula.

Putting it on the map

Using an add-in supplied with each
spreadsheet, Excel, Lotus 1-2-3 and

Quattro Pro can make maps. When you think
about it, sailors are right to call maps charts
because they just chart data. The spreadsheet
can tabulate data and the mapping add-in
graphically illustrates it. At a local level, once
the usual demographic statistics have been
colour-keyed, the map can be edited to even
pinpoint your favourite family picnic sites.

The three leading spreadsheets all
provide a certain amount of sample

demographic data to get you started with
mapping. Here’s an example of the census
statistics, which come with Quattro Pro. The
data is provided in list form: the columns are
fields, the rows are records. The mapping
add-in knows where to put the information 
by the order of the fields or columns. Once
you know the order you can create the tables
you need.

Lotus 1-2-3 offers the most extensive
help files for mapping, and even an

animated demo. We’ll use Excel for this
workshop but the Lotus 1-2-3 and Quattro Pro
mapping procedures are quite similar. If you do
the full Lotus 1-2-3 installation, by default, this
file, called world.123, will be installed in the
C:\lotus\samples\123 directory. Although the
statistics may not be current, at least Lotus
1-2-3 offers more extended definitions of the
succinct field names under one tab.

21 3

If you want to move the map around
in its frame, click on the Grabber tool

in the Map toolbar then drag the map. To
release the tool, click on another one. To add
text, as here, click on the Text tool with the big
A then enter the text. You can format the font
and its colour with a right-click. You can also
click and drag the Map toolbar itself to a
preferred position.

When the Map is active (double-click
on it) and the Map toolbar is showing,

the regular Help menu changes to Map topics
only. To return to the underlying Excel
worksheet, click outside the map area. If you
open the datainst.exe file (which by default is
installed in the C:\Program Files\Common
Files\Microsoft Shared\Datamap\Data
directory) more features are available for the
UK. Choose Features in the Map menu and
add Display major cities or airports.

Excel includes more maps in the
mapstats.xls file, which by default is

also installed in that directory. Click on the
Europe tab to see all the data available. To
select the data, use the dropdown box on
the left of the Formula Bar. Hover the mouse
over the pink field names. Displayed
comments give a description of the statistics:
male, female and total population numbers
for each country from 1975 to 1993, and
lots more.

8 97

Amnesty hits on an appealing idea  

Open Excel and click on the Map
tool or choose Insert, Object,

Microsoft Map. Drag a rectangle on your
worksheet and a dialog box appears headed
‘Unable to Create Map’. It should say ‘Choose
the Map You Need’ because a list of maps is
offered. Pick UK and ROI (Republic Of
Ireland) Counties. When that’s drawn,
right-click on the huge black default heading
and reformat to a font, size and colour that’s
more pleasing.

Choose Tools, Options, View and
uncheck the Gridlines box. Drag a

corner of the map to make it a satisfactory
size. Double-click on the map and the Map
toolbar appears. Click on the tool that looks
like a parcel label, and choose OK in the
resulting dialog box. When you hover the
mouse over the map, county names will
appear. To display one permanently, click it,
then drag it to the preferred position. Right-
click to format it.

Click the Push Pin tool on the Map
toolbar, then enter a name for a

custom map in the resulting dialog box. Click
OK and the cursor changes to a Push Pin.
Click on the location where you want a Push
Pin, and then fill in a descriptive name in the
displayed dialog box. You can drag the Push
Pin and the label separately to their preferred
positions, and you can right-click and
reformat the label.

54 6

For a simpler map click on the
Canada tab and then Canada in the

dropdown box. Click the Map tool and draw
a large rectangle. This not only produces a
map of Canada, but also displays the Map
Control box. Drag the Bar Chart symbol into
the main box over the Format square and two
or three of the offered fields – such as Total
Families, Single-Parent Families and
Husband-Wife Families – over the Column
square. Close the box.

The new Bar Chart legend box can
now be dragged where you like.

Right-click this object, and you can edit and
reformat the text, add a subhead, change the
bar colours – there are many options. The
legend box gives the totals of each statistic for
the country. Equivalent mini-charts for each
of the heavily populated provinces are
displayed on the map. A tool on the Map
toolbar lets you re-display the Map Control
dialog box. 

You can obtain a variety of data sets
for Excel maps from the MapInfo

website at www.datasets.com. Mapping data
sets for Lotus 1-2-3 and Quattro Pro are
available from www.esri.com. You can make
maps showing golf courses, hospitals, parks
and pubs. Transportation maps show
motorways, railway lines, canals and tunnels.
Area boundaries include parishes or voting
wards. Post-coded data can give expenditures
on groceries or readership of newspapers.
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Useful contacts
Excel: www.microsoft.com/catalog/display.asp?
subid=22&site=797&x=28&y=18
Lotus 1-2-3: www.lotus.com/home.nsf/tabs/
lotus123
Corel Quattro Pro: www.uk.corel.com/products/
wpo2000.html#topic_4
StarCalc: www.sun.com/products/staroffice/5.2


